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Use this document to print a paper copy of the information on how to use The Amazon Trail 
software. The information in this document is also available in an easy to use format, while you 
are playing. Pull down the Help menu while you are using the program and select Quick Help for 
a quick reference or Online Manual for more extensive information.

MECC Technical Support can help you with problems not covered in the online help or this 
document. (See MECC Technical Support at the end of this document for information on how to 
request help.)

Installation

To install The Amazon Trail:

1. Insert the program CD-ROM into your CD-ROM drive.

2. In the Program Manager screen, choose Run from the File Menu. You see the Run window.

3. Type D:\SETUP (D is the letter of your CD-ROM drive.  If your CD-ROM drive is not D
substitute accordingly) in the Command Line box. Click on the OK button.

4. Follow the on-screen instructions. When the installation is finished, you return to Windows.

Sound Effects and Music

There are enjoyable sound effects throughout the program, and when you reach a landmark you 
hear melodies that are based on traditional South American folk music. You must have a sound 
card installed in your computer and external speakers to hear the sound effects and music.

Starting the Game

To start the game:

1. Double-click on the MECC group.

2. Double-click on the Amazon Trail icon.

The program begins with a dream sequence. After you have played the game a few times, 
you may not want to watch it. Press the Esc key or click on the screen with your mouse to 
stop the dream and go to the title screen.

3. Click on one of the buttons that appear on the title screen.

"Start a new quest" begins a new game.

"See Hall of Shields" takes you to the Hall of Shields, which is described under "Entering the 
Hall of Shields". 

"Load a quest" opens a game you saved earlier (for more information, see "Open a Saved 
Quest").

Using Shortcut Keys
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Ctrl-G Save your game

Ctrl-X Quit the program

Esc From the dream sequence: Go to the title screen

Playing the Game

The object of the game is to get some cinchona -- a medicinal plant that cures malaria - and 
deliver it to the Inca King in the hidden city of Vilcabamba. If you get the cinchona, the King will 
also ask you to bring some other items.

It is a very good idea to save your game frequently. For more information, see "Save Quest".

Things to Do in Belem

Use the following buttons to:

Go to the River
Click on the River button to start upriver. You will also use this button to return to the river from 
other screens.

Talk to your Guide
Click on the Guide button to talk to your guide.

Supplies
Click on the Supplies button to check your supplies. When you check your supplies, use the 
Photo button to look at the photo album. Use the Basket button to see what you have collected 
for the Inca King. 

Map
Click on the Map button to check the map.

Guidebook
Click on the Guidebook button to read the guidebook. Within the Guidebook, you can click on the 
button that looks like an ear to hear how the guidebook entry is pronounced.

Talk
Click on the Talk button to talk to people at the landmark you are visiting. 

Starting Upriver

When you start upriver, you will use many of the same buttons you used on the starting screen. 
You can also use the following buttons:

Explore
Click on the Explore button to explore the rainforest. 

Go Fishing
Click on the Fishing button to go fishing.

Canoeing

You'll never run aground. If you get too close to the shore, your guide steers you away. If you 
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want to go into the rainforest, click on the Explore button.

Point the camera to the left, center, or right, according to where you want to go. If you see a hut 
or an animal, click on it.

The little disturbances in the water are either whirlpools or sunken logs. Steer clear of them.

As you canoe up the river, you will notice a bar on the top of the screen, this your health meter.

If You Were Really Canoeing on the Amazon

• You cannot always see both shores. At some points, the Amazon is more than 30 miles 
across!

• There are more islands and tributaries than appear in the program. The Amazon has ten 
tributaries that are at least 1,000 miles long. One tributary, the Madeira River, is itself the 
fourth longest river in the world.

• There is a lot of boat traffic. Canoes are a common form of transportation, but they are used 
for short distances. Motorized boats are used for long distances.

• There are four basic types of rivers in Amazonia. Each has its own distinctive color. White-
water rivers appear in the slopes of the Andes Mountains. They are clear and pure. As these 
rivers drop into the Amazon basin, they slowly gather sediment (dirt) and become brown-
water rivers. The Amazon River itself is brown. 

• On the south side of the Amazon River, most of the tributaries are blue-water rivers. These 
flow very slowly, and so the sediments in them tend to float to the bottom of wide spots in the 
rivers. On the north side of the Amazon River, most of the tributaries are black-water rivers. 
Rotting vegetation turns the water into a color that looks like dark tea. The vegetation itself 
tends to settle out in swampy areas before it reaches the main rivers.

• There are two seasons in Amazonia: the dry season and the rainy season. Each lasts about 
six months. During the dry season, skies are clear for up to ten hours per day and rain 
showers are brief. During the rainy season, skies are usually cloudy and heavy showers are 
common. Water comes not only from rainfall but also from snowmelt from the Andes 
Mountains. The elevation of the rivers can rise 40 feet or more in the rainy season. Vast 
areas  of the rainforest are flooded, and navigation becomes more difficult.

• The Amazon basin is about the same size as the United States (not counting Alaska) or 
Europe.

• Twenty per cent of all fresh water on Earth -- one gallon out of every five -- is in the Amazon 
River.

Exploring the Rainforest

In the rainforest, click on the arrows on each side of the scene to move up or down, left or right.
Watch carefully! Sometimes a tiny movement will betray the presence of an animal. When you 
see something, move the camera on top of it and click. If you "get" it, you'll see a full-blown 
picture of it.There are a number of plants to be identified, too. Click on the vegetation when you 
see something that looks promising.

There are a number of plants to be identified, too. Click on the vegetation when you see 
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something that looks promising.

When you identify an animal or plant, a picture of it goes into your photo album. The photo album 
is with your supplies. If you reach Vilcabamba, the Inca King gives you credit for each animal or 
plant that you identify. To identify something, you have to click on the Identify it button and make 
the correct choice. If you find the same animal or plant a second time, you don't have to identify it 
again.

If You Were Really Exploring in the Amazon Rainforest

• Along the banks of rivers, where there is plenty of sunshine, the vegetation is very dense. 
That's why, in The Amazon Trail, you need a machete to go exploring. You might think that 
the whole rainforest is like that, but it isn't. At high noon inside the rainforest, only 1% of the 
sunlight reaches the forest floor. The rest is blocked out by the trees. As a result, there is a lot
of open space on the ground.

• It's very difficult to see animals, especially ones that live in the upper canopy. Only recently 
have scientists begun to use scaffold-and-rope systems to observe the plants and animals 
there. As many as half of all species on earth may live in the world's rainforest canopies.

• The Amazon is more a place of sounds than sights. You are much more likely to hear an 
animal than to see one.

• Considering how much vegetation there is, you would think that rainforest soil would be very 
rich. But it's not. Almost all the nutrients are tied up in the living plants. Leaf litter on the 
tropical rainforest floor is typically one inch deep, and topsoil is two inches deep. In temperate
forests, leaf litter can be a foot deep, and topsoil seven feet deep.

• No one knows for sure, but there may be as many as 80,000 species of plants in the Amazon,
about 16% of the world's total. There are usually between 40 and 100 species of trees in 
each two and a half acres of rainforest. By contrast, most North American forests have no 
more than 20 species in a comparable area. It can be very unusual to see two trees of the 
same species in one area.

• The entomologist (insect scientist) Edward O. Wilson once found 43 species of ants in a 
single tree. Entomologists are continually discovering new species of insects in Amazonia.

• It is very rare to see a snake, and even more rare to be bitten by one.

• Only 25% of the water in Amazonia ever leaves the basin; the rest is returned to the 
atmosphere by evaporation. The moisture that is returned to the atmosphere falls again as 
rain. If this cycle is disrupted by cutting down too much of the rainforest, the rainforest will 
never be able to regenerate itself.

Visiting Landmarks, Talking, and Trading

At each landmark, there are two people you can talk to. Click on the Talk button (the one with two 
people on it). Some people provide valuable clues for a successful journey. One reason to trade 
is to get something you need, like a machete or some food. Another reason is to get items that 
the Inca King wants. Here's how to trade:

1. When you are at a landmark, click on the Talk button. Click on "Do you want to trade?" If you 
see something you like, click on it.
In addition to cinchona, the Inca King may want other items as well. So you might think that 
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you should try to get whatever you can. But there are plenty of things that the Inca King 
doesn't want. By trading for an unwanted item, you wind up trading something valuable for 
something worthless.

2. Click on the left and right arrows to scroll through your possessions. Click on the item that 
you are willing to trade. Use the pop-up menu to change the quantity.

3. Click on "Is it a deal?" If the person accepts, click on "It is a deal."
The items that you get by trading are stored in one of two places. If it's something that the 
Inca King wants, it appears in the basket holding your supplies. (Click on the Supplies button;
then click on the Basket button.) If the item is something that the Inca King does not want, it 
appears in the scrolling list of things that you can trade.

If You Were Really Visiting Amazonia

• The pictures of the landmarks in The Amazon Trail do not always show how those landmarks 
look today; they convey a sense of how the landmarks may have looked during the historical 
period in which you visit. The pictures are computerized versions of photos that were taken in
the Leticia-to-Iquitos area of the river in 1992.

• People speak many different languages. The official language of Brazil is Portuguese, and 
the official language of Peru is Spanish. There are dozens of Indian dialects; most are based 
on one of five main languages.

• Trading is a way of life, especially for the caboclos - the people who live along the river. They 
commonly get things they need by trading fish or items that they collect in the rainforest.

• The Amazon's first human inhabitants - commonly referred to as Indians - migrated from the 
north and reached the Amazon basin about 10,000 years ago. The size of the population 
when Europeans arrived in the sixteenth century was somewhere between two million and 15
million. Today only about 200,000 remain. The rest died as the result of slavery, diseases, 
and other disruptions to their societies. More than 90 Amazonian tribes have died out in the 
twentieth century.

• Most destruction of the Amazon rainforest has occurred as the result of big banks and 
corporations trying to convert the Amazon's natural resources into monetary wealth. The 
majority of people who live in Amazonia, however, are very poor. They move away from 
desperate poverty in other parts of Brazil and try to carve out a living from the rainforest. In 
most cases, their condition only worsens.

Fishing

You can go fishing whenever you are on the river. Just click on the Fishing button.
Be patient and persistent. When you see a fish moving, follow it for a moment or two with your 
harpoon. Try to position the tip of the middle prong of the harpoon on top of the fish. Then click.
You can return to the river at any time. Click on the Arrow button.
You can change the length of time allowed for fishing. See "Options."

When you catch a fish:
• Click on "Keep It," if you want to eat it.
• Click on "Look it up," if you're not sure what to do. 
• Click on "Release it," if you think it might hurt you.

If You Were Really Fishing on the Amazon
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• There are at least 2,000 species of fish in the Rivers Amazon. Many, including some that you 
encounter in the program, are commonly caught for food. Many others are caught for the 
tropical fish market. The best place to see fish is at the fish markets in the river towns.

• Different species of fish live in different habitats and water depths. In The Amazon Trail, all 
the fish are mixed together.

• Local people use a variety of methods to catch fish. Yes, harpoons and spears are used. So 
are nets and traps. Some Indians use bows and arrows. Some Indians make a potion that 
paralyzes fish.

Reading the Guidebook

You can read about plants, animals, people, places, trade items, diseases - everything that you 
encounter on The Amazon Trail. Sometimes the guidebook contains valuable clues.

When the Guidebook is open:

• Click on the upper right or left corner of the book to turn the pages.
• Click on the Index tab on the right edge of the book to see the list of topics.
• Click on the Listen button in the lower right corner to listen to parts of the guidebook. The 

words are from several different languages, including Spanish, English, and Portuguese.
• Click on the Arrow button in the lower left corner when you're done.

Checking Your Supplies

Supplies
Click on the Supplies button to check on your supplies. It's especially important to keep an eye on
how much food you have. If you're running low, you can trade at a landmark or go fishing. The 
Supplies screen contains two other buttons - the Basket button and the Photo Album button.

Supplies Basket
Click on the Basket button to see what you have collected for the Inca King.

Photo Album
Click on the Photo Album button to see the plants and animals that you have identified. In the 
Photo Album, click on the upper left and right corners to turn the pages.

Working with Your Guide

Talk to your guide
Click on the Guide button to check in with your guide. The guide can help you rest, change your 
pace or rations, and tell you how you're doing.

Resting helps you recover from illness or injury. Increasing your pace will help you get to 
Vilcabamba faster, but the stress of fast paddling makes you more likely to get sick or injured. 
Increasing your rations helps keep you healthy but uses up your food supply more quickly. 

Click on the Adios button when you're done.

Checking the Map

Map
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Click on the Map button to see where you are. You can also move the pointer around the map to 
learn the location of the different cities and rivers. If it turns out that you are on a dead-end 
tributary, you can turn around.

Entering the Hall of Shields

If you make it to Vilcabamba, the Inca King will honor you with a shield. You get a gold shield if 
you bring cinchona; otherwise you get a bronze shield. The shields contain jewels that represent 
the number of animals and plants you identified, the number of items you collected for the King, 
and the number of people you met. The more jewels you get, the more valuable is your shield.

Gold shields are eligible to be placed in the Hall of Shields. The best eight shields are displayed 
there. Click on any one of the shields to have the Inca King tell you about it.

After you have played The Amazon Trail a few times, you may decide to remove the shields and 
start over. See "Clear Hall of Shields."

Menus

File Menu

New Quest Starts a new game. If you are already in the middle of a game, you will 
get a chance to save it before you start the new game.

Open a Saved Quest Opens a saved game. When you see the Open dialog box, double-click 
on the name of the game you want, or click on the name and click on the 
OK button.

Save Quest (Ctrl +G) Saves your game.

When you see the dialog box, type a name for your game and click 
on the OK button. If you have saved a game with the same name before,
you will replace the older game with the version that you are now saving.

There are at least three good reasons to save your game frequently. 
First, you protect yourself against an unexpected computer breakdown. 
Second, you may not be able to finish a game at one sitting. If you save 
your game, you can restart it later at the point where you left off. Third, 
you never know when you might drown or succumb to yellow fever or get
captured by headhunters or conquistadors. If you have saved your game,
you can restart it at a point before the disaster struck, change your 
strategy, and perhaps prevent the disaster.

Here's a good way to use the Save Quest command: Save a 
different version of a game whenever you reach a landmark. For 
example, when you reach the Xingu River, you can save your game 
under the name "Xingu." Later, you can open a saved game to return to a
landmark to talk and trade with the people who are there.

Exit (Ctrl +X) Quits The Amazon Trail and takes you back to Windows.

Game Menu

Sound Turns sound effects, including the guidebook pronunciations, off and on.
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Music Turns the music off and on.

Note: You can disable the Sound and Music commands by using the 
Options command on the Management menu. See "Options" below.

Time Out Interrupts the game. When you are ready to continue, click on the 
Resume button.

Management Menu

The Management menu provides parents and teachers with control over certain aspects of The 
Amazon Trail. In order to use commands on the Management menu, you need to enter a 
password. The password is DREAM.

About Management Summarizes the Management menu commands.

Enable Management Displays a dialog box in which you enter the password. After you use this
command, its name changes to Disable Management. If you want to 
prevent people from using the Management menu commands, you 
should choose Disable Management.

Clear Hall of  Shields Lets you remove all shields from the Hall of Shields.

Options Lets you do the following things:

Turn sound and music on or off. If you choose to turn them on, users 
can still turn them off by using the commands on the Game menu. If you 
turn them off, the commands on the Game menu are no longer available.

Adjust the length of time allowed for fishing. A shorter time makes 
fishing more challenging.

Change Password This command lets you change the password from "dream" to a word of 
your choice. Letters, numbers, and/or punctuation marks are allowed in 
passwords. 

Help Menu

About Amazon Trail Lists the people at MECC who created The Amazon Trail and indicates 
the version number.

Quick Help Provides a quick reference. You can open this information while you play.

Online Manual Provides complete information on the program. You can open this 
information while you play.

Learning More About the Amazon

Rainforest Activities

1. Rainforest terrariums! Build a rainforest in a two-liter soda bottle. Use philodendron cuttings, 
potting soil, and water. Write to: Bottle Biology Project, University of Wisconsin, 1630 Linden 
Dr., Madison, WI 53706.

2. Amazon adventure! Plan an Amazon trip. Contact travel agents to find out about trips there. 
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Look for the March/April 1993 issue of Buzzworm - The Environmental Journal. It has a 
directory of "ecotravel" outfitters who lead Amazon expeditions.

3. Letter writing! Write your public officials to find out what their position is on rainforest 
protection. Consult Barbara Lewis's book, The Kids' Guide to Social Action, 1991. It outlines 
projects and samples of letter writing for social causes. See also Betty Miles's book, Save the
Earth: An Action Handbook for Kids. Alfred A. Knopf, 1991.

4. Raise money for rainforests! Did you know that you can actually buy rainforest land? Contact 
Rainforest Rescue, c/o The National Arbor Day Foundation, 211 North 12th St., Lincoln, NE 
68508.

5. Get involved! Write one of these organizations for more information about rainforests:
Center for Environmental Education: 624 9th St. NW, Washington, DC 20001
The Children's Rainforest: PO Box 936, Lewiston, ME 04240
National Wildlife Federation, International Programs: 1400 16th St. NW, Washington, DC 
20036
The Nature Conservancy, Latin America Division: 1815 N. Lynn St., Arlington, VA 22209
Rainforest Action Network: 300 Broadway, Suite 28, San Francisco, CA 94133
Rainforest Alliance: 65 Bleeker St., 6th Floor, New York, NY 10012
World Wildlife Fund: 1250 24th St. NW, Washington, DC 20037

Recommended Reading

For Pre-teens

Baker, Lucy. Life in the Rainforests: Animals, People, Plants. Franklin Watts, 1990. A reference 
book that addresses a number of rainforest topics.

Baptista, Lynne Hardie. Discover Rain Forests. Publications International, Ltd., 1992. A large, 
colorful book that introduces rainforest ecology.

Cherry, Lynne. The Great Kapok Tree. Gulliver Books, Harcourt Brace Jovanovich, 1990. An 
illustrated story-book that is considered a modern classic for younger readers.

Dorros, Arthur. Rain Forest Secrets. Scholastic, Inc., 1990. An illustrated introduction to rainforest 
concepts for younger readers.

Flora. Feathers Like a Rainbow: An Amazon Indian Tale. Harper Row, 1989. An enchanting 
retelling of an Amazonian myth.

Forsyth, Adrian. Journey Through a Tropical Jungle. Simon and Schuster, 1988. Description of a 
scientist's expedition in the rainforest of Costa Rica.

George, Jean Craighead. One Day in the Tropical Rain Forest. Simon and Schuster, 1988. An 
overview of life in the rainforest as seen in one 24-hour period.

Stone, L. Rain Forests. Rourke Corp., 1989. An introduction for 5th-8th graders.
Taylor, Barbara. Rainforest. A Dorling Kindersley -- Look Closer Book, 1992. A colorful overview; 

one in a series of interesting new books.
Willow, Diane. At Home in the Rain Forest. Charlesbridge, 1991. A brief introduction to 

rainforests, with color illustrations.

For Older Kids and Adults

All of these books were used in doing research for The Amazon Trail.

Cowell, Adrian. The Decade of Destruction. Henry Holt and Company, 1990. An account of the 
work of the Villas Boas brothers, as well as reports on gold mining, rubber tapping, and cattle 
ranching in the 1980s.

Eu, Geoffrey, ed. Amazon Wildlife. APA Publications, 1992. An overview of Amazonia. Heavily 
illustrated. Includes information for tourists.

Goodman, Edward J. The Explorers of South America. University of Oklahoma Press, 1992. 
Stories of everyone from Francisco de Orellana to Gene Savoy.



The Amazon Trail Reference Guide 10
Goulding, Michael. Amazon: The Flooded Forest. Sterling Publishing, 1990. Describes the 

phenomenon of flooded forests; includes detailed information on the fish and other animals 
that live in this ecosystem.

Hecht, Susanna, and Alexander Cockburn. The Fate of the Forest: Developers, Destroyers, and 
Defenders of the Amazon. Harper Collins Publishers, 1990. An account of what's happened 
from the sixteenth century to the present.

Kricher, John. A Neotropical Companion. Princeton University Press, 1989. A fact-filled book on 
the natural history of tropical rainforests in Central and South America.

McIntyre, Loren. Amazonia. Sierra Club Books, 1991. A blend of human history, natural history, 
and stunning photography.

Historical Adventures

Here's a list of books written by some of the characters in The Amazon Trail. A few of the books 
are relatively new or have been reprinted; these may be available at your bookstore. Most of the 
books are out-of-print and are available only at your library. These books may be hard to find, but 
the search is worth it. If you think Indiana Jones had some adventures in the Temple of Doom, 
wait 'til you read about Teddy Roosevelt on the River of Doubt!

Agassiz, Louis and Elizabeth. A Journey in Brazil. Fields, Osgood & Co., 1869.
Bates, Henry Walter. The Naturalist on the River Amazons. Penguin Books, 1988.
Fawcett, Col. P. H. Lost Trails, Lost Cities. Funk & Wagnalls Co., 1953.
Humboldt, Alexander von. Personal Narrative of Travel -- (translated and edited by Thomasina 

Ross). Ayer, 1969.
Roosevelt, Theodore. Through the Brazilian Wilderness. Charles Scribner's & Sons, 1921. 
Schultes, Richard E. Place Where God Reigns. Synergetic Press, 1988.
Spruce, Richard. Notes of a Botanist on the Amazon. Edited by A. R. Wallace. Macmillan and 

Co., 1908.
Wallace, Alfred Russel. Travels on the Amazon and Rio Negro. Ward, Lock & Co., 1853.

Troubleshooting

Installing the Program

Problem   "Not enough hard disk space"
Solution   Make sure you have enough space available on your hard disk. The installation 
program shows the amount of hard disk space required.
1. Start the installation to check the amount of space required. When you find the information, 

press Esc to stop the installation.
2. Choose the File Manager icon from the Main group in the Program Manager.
3. Choose the icon for the drive you want to check. The number of bytes of free disk space is 

shown in the status bar at the bottom of the File Manager window. This number should be 
larger than the amount of space the installer indicates you need. (If the status bar does not
appear, display it by choosing Status Bar from the Options menu.)

4. If there is not enough space, remove unneeded files from your hard disk and try installing 
The Amazon Trail again.

Problem   "Unknown" error message during installation
Solution    Data is not being transferred to your hard disk. This may be the result of a problem 
with your hard disk. Contact your computer dealer for assistance. 

Starting and Using the Program
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Problem   I installed The Amazon Trail, but it doesn't run.
Solution   You may have missed one of the installation steps. Follow the installation directions in 
the jewel case exactly.

Problem   The program is running very slowly.
Solution   Your system is probably low on memory. 

If the small light on your computer is lit often, you are probably low on memory. The light is lit 
when Windows swaps information to the disk to make more room for other information or rereads 
information from the disk. 

To speed up the program, you need to make more memory available by:·
• Closing other programs you have open or running. These programs may be using memory.·
• Consulting your Windows documentation for information on freeing up memory or optimizing 

Windows, if closing other programs does not speed things up.

Problem   The access time on my CD ROM is very slow. Is there anything I can do to improve it?
Solution    Sorry, no. The access time depends upon your CD drive. 

In the Program

Problem   The Amazon Trail was running, but then it disappeared.
Solution    You may have clicked outside the game window. The game is still running, but it may 
be covered by another window. To return to your game, try one of these options:

If you can see the edge of the game screen, click anywhere on the visible part of the game 
screen.

Press Alt-Esc until the game screen appears and is active.

Press and hold down the Alt key while pressing the Tab key to cycle through all of the open 
programs. Release the Alt key when you see The Amazon Trail icon.

Sound and Music

Problem   I don't hear any sound or music.
Solution   Make sure that the sound and music options are turned on. If they are, you see a 
check mark next to Sound and Music on the Game menu.

Problem   I turned on the Sound and Music, but I don't hear anything.
Solution   Check that you have a Microsoft-compatible sound card installed and that your sound 
device is set up properly for MIDI sound. If you are sure you have a sound card installed in your 
computer, you may not have installed the correct drivers for your card. 

To install the sound drivers for your sound card, follow the manufacturer's directions. (As a part of 
the Windows installation, the following sound drivers are installed: MIDI Mapper, Timer, [MCI] 
MIDI Sequencer, and [MCI] Sound.)

To test your sound card and sound driver:
1. Go to the Windows Program Manager and open the Main Group.
2. Double-click on the Control Panel. Then double-click on MIDI Mapper.
3. Open the Name listing and select a name which includes the letters "FM" or "Ext FM." Then 

click on Close.
4. Select the File menu from the Program Manager, then select Run.
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5. Type MPLAYER canyon.mid in the Command Line box and click OK.
6. Click on the Play button (the first lower left button) to play the music. To stop the song, click 

on the Stop button. 

If your sound drivers are installed properly and the correct MIDI Mapper is selected, you should 
hear the song. 

If you get an error message from Windows ("There are no MIDI devices installed on the system" 
or "The current MIDI Mapper set-up refers to a MIDI device that is not installed on the system"), 
contact your sound card manufacturer for set-up instructions.

If you can play the canyon.mid song in the Media Player, start The Amazon Trail program. If 
Music and Sound in the Game menu have check marks next to them, you should hear the sound 
and music for the program.

MECC Technical Support (MECCTECH)

If you have a question about using MECC software:
• Note the name and version number of the software.
• Note the brand and model of the equipment involved.
• Please be in front of your computer when calling.
Call MECCTECH Line (Automated Support System) at 612/569-1678 to receive answers to the 
most commonly asked technical questions about MECC products 24 hours a day, 7 days a week. 
The Automated Support System offers convenient fax-back capability for technical tips as one of 
its many features.

You can speak with a Technical Support Representative by calling 612/569-1678 Monday - Friday
from 8:00 a.m. to 5:30 p.m. Central Time.

You can write MECC Technical Support, 6160 Summit Drive North, Minneapolis, MN 55430-4003.

Credits

Producer Craig Copley
Project Management Denis Burger, Jr.
Art Charolyn Kapplinger
Music, Voice, Sound Larry Phenow, Chad Iverson, and 

Glen Anderson
Guidebook Voice Erica Palmquist
Programming Dwayne Towell, Lars Nesbakken, Tom Good, 

Wes Evans, Todd Bates
Testing Dawn Wichmann, Vang Thao, Sue Minor,

Dan Megears, josef ling, Shauna Gonzales,
Henry Beigh 

The Amazon Trail CD and Windows are based on the original Macintosh and DOS version of The 
Amazon Trail produced by: Project Management- Chuck Bilow; Design- Mike Palmquist; Art- Ed 
Madrid, Charolyn Kapplinger, Sandra Forslund, John Diebel; Music and Sound Effects- Larry 
Phenow; Writing- John Hickman; Programming- Jeff White, James Thompson, Randy 
Rasmussen, John Ojanen, Al Lathrop, Julie Redland Kmoch, Mark Hanson, Susan Gabrys; 
Testing- LaDonna Williams, Dawn Wichmann, Mark Schneider, Sue Minor, Dan Megears, Barry 
Mansur, josef ling, Mark Larson, Ron Helwig, Todd George, Nursen Bilge, Glen Anderson, Brian 
Anderson; Research- Sue Thomas; Voice- Claudia Moreira Ciesynski.
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MECC's Learning Guarantee
Guaranteed Learning. Guaranteed fun. We're so sure kids will improve in the key learning areas 
included in this product that we guarantee it. If you don't see improvement as a result of regular 
use of this software, we'll exchange it or give you your money back. Simply return the complete 
package, along with a receipt showing the store name and location, to MECC within 30 days.

MECC
6160 Summit Drive North

Minneapolis, Minnesota 55430-4003

Learning objectives for The Amazon Trail: 
• Practice decision-making skills
• Develop problem-solving skills
• Practice reading-comprehension skills
• Develop or increase interest in tropical rainforests

Softkey License Agreement

This agreement governs your use of the SoftKey products enclosed with it including any  
manuals, disks, computer program and materials associated with it (the "Software").

BY  OPENING THE SEALED PACKAGES CONTAINING THE DISKS AND/OR BY  USING THE 
SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS  AGREEMENT. IF YOU 
DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,  PROMPTLY RETURN THE 
UNOPENED DISK PACKAGES TO THE PLACE YOU  OBTAINED THEM FOR A FULL 
REFUND. 

1.  Grant of License. 
This Agreement permits you to use one copy of the Software, which  is licensed as a single 
product. The Software is "in use" on a computer when it is loaded  into the temporary memory 
(i.e., RAM) or installed into the permanent memory (e.g.,  hard disk or other storage device) of 
that computer. You may use the Software on a  network provided you have purchased one copy 
for each user. 

2.  Copyright and Restrictions. 
The Software is owned by SoftKey or its suppliers and is  protected by United States and 
Canadian copyright laws and international treaty  provisions. SoftKey, its suppliers or licensors 
retains all rights not expressly granted.  You must treat the Software like any other copyrighted 
material, except that you may  either make one copy of the Software solely for backup or archival 
purposes or transfer  the Software to a single hard disk provided you keep the original solely for 
backup or  archival purposes. You may not rent or lease the Software, but you may transfer your  
rights under this Agreement on a permanent basis provided you transfer the license  granted by 
this Agreement, the Software and all associated printed materials, retain no  copies and the 
recipient agrees to the terms of this Agreement. You may not reverse  engineer, decompile or 
disassemble the Software, except to the extent the foregoing  restriction is expressly prohibited 
by applicable law. 

3.  Limited Warranty. 
For 90 days from your date of purchase, SoftKey  or its suppliers warrants that the media on 
which the Software is distributed are free from  defects in materials and workmanship. SoftKey 
will, at its option, refund the amount you  paid for the Software or repair or replace the Software 
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provided that (a) the defective  Software is returned to SoftKey or an authorized dealer within 90 
days from the date of  purchase and (b) you have completed and returned the enclosed 
registration card. These  are your sole remedies for any breach of warranty. SoftKey, its suppliers 
and licensors  disclaim all other warranties, either express or implied, with respect to the Software
and  the accompanying written materials, including but not limited to implied warranties of  
merchantability and fitness for a particular purpose. 

4.  Limitation of Liabilities. 
In no event will SoftKey, its suppliers or licensors be liable for any indirect, special, incidental, 
economic or consequential damages arising  out of the use or inability to use the Software, even 
if such party has been advised of the  possibility of such damages. In no event will SoftKey, its 
suppliers or licensors' liability  exceed the amount paid by you for the Software. Because some 
jurisdictions do not allow  the exclusion or limitation of liability for consequential or incidental 
damages, the above  limitation may not apply to you. 

5.  U.S. Government Restricted Rights.  
The Software is provided with RESTRICTED  RIGHTS.  Use, duplication or disclosure by the 
Government is subject to restrictions as  set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer  Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) 
and (2) of the  Commercial Computer Software--Restricted Rights at 48 CFR 52.227-19, as 
applicable.  SoftKey International  Inc., One Athenaeum Street, Cambridge, MA 02142. 


